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ProValPlus 
Administrative Maintenance 
 
 

 

To Open a Parcel, you can 
either click the file open icon 
(shown to the left), OR from 
the File menu, select “Open 
Parcel”, as shown below left. 

 

Either way, this screen pops up 
for you to enter the selection. 
 
Special Note:  If working on a 
range of parcels, by opening up a 
range, you will be able to click 
from one parcel to another within 
the parcel tree. 
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Certain changes can be made on this screen.  Anywhere the screen is white, a 
change can be made. 
 
 
 
 

 

For all other changes, 
select the appropriate 
option from the 
Administrative Menu 
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Key Info Option: 
 

 

Where you would change: 
• Alternate PIN (Alt PIN) 
• Property Class 
• Neighborhood 
• Legal Acres/ Sq Fet 
• Also display’s the relative 

serial number (lrsn) for 
this parcel. 

 
New Parcel: 

 

 

Things to remember about entering 
a new parcel: 

• Area is ALWAYS 001 
• New Parcel ID is ALWAYS 

ENTERED with alpha 
characters CAPITALIZED 

• Optionally, you can copy 
ownership from another 
parcel 

 
New Economic Unit Master: 

 Same as New Parcel 
 
New Condo Project: 

 Same as New Parcel 
 
 
 
 

 3



Change Parcel Number: 
 

 
 
Parcel Status: 
 

 

In order to change a parcel 
number to another number, 
the parcel that you are 
changing must be the parcel 
that you have open.

If the parcel is an active parcel, the 
prompt will ask you if you would like 
to “Inactivate” this parcel. 

 

 

If the parcel is currently Inactive, the 
prompt will ask you if you would like to 
make it “Active”. 

 
Split: 
 

 

Be sure the parcel that you 
are retiring is the active 
parcel. 

Enter the number of parcels you 
are splitting into & be sure the 
“Retires” button is selected. 
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A 

B

C 

 

 

D 

E 

 
 

A. Enter the parcel number of the first child parcel. BE SURE to use UPPER 
CASE. 

B. Enter the Acreage for this child parcel (The starting gross & net acreage is 
listed to the left) 

C. IF any property records are to be assigned to this child parcel then select this 
option. 

D. When this screen comes up, highlight the property records to be assigned to 
this child parcel then click OK. 

E. Repeat A through D for each child parcel. When finished with all child 
parcels, click on “Split Done”. 
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Merge: 
 

 

Be sure the parcel that you are 
merging into is the parcel that is 
open. 
 
NOTE: This may (& usually does) 
require you to create a new parcel 
first. 

 

 

A 

CB 

 
A. Enter Parcel Number of the parcel to merge into the parcel you have open 
B. Click “Next Parcel” to enter the next parcel to merge 
C. When you have entered the required number (as set in the first screen) the 

program will not advance any further. At that point, you will need to click OK 
(not shown above). 

 
Delete Parcel: 
 

 

If you try to delete a parcel that is 
“Active”, you will get this 
message. If the parcel truly does 
need to be deleted, then you will 
need to change the parcel status 
before deleting the parcel. 

 

You will get this warning. If you 
truly want to delete the parcel, 
select Yes. 
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Memos: 
 

 

If it is a new memo, double 
click on the “New Memo” 
line.  
If editing an existing memo,  
double click on that memo 

 

 

If it’s a new memo , then select the 
memo from the list (your list will 
be different from this list). 
NOTE: If the memo you are after 
is not in this list, then it will have 
to be added through Tables 
Maintenance. 

 

 

If it is an existing memo, you can: 
• Add/Change comments under 

the memo 
• Delete the memo. 
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Legal Description: 
 

 

You can modify the legal 
description ever how it needs 
to be done.  The number of 
lines is basically unlimited. 

 
 
Update Transfer (Sales) History: 
 
 Note:  A “Transfer” is a Sales in Progress. 
 
 

 

If more than one entry, 
highlight the entry you 
need to work with, 
then click Edit. 
If a new transfer needs 
to be added, click Add. 
If an entry needs to be 
deleted, click Delete.
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If adding or editing, the above screen pops up. Required fields on this 
screen are: 

• Grantor 
• Grantee 
• Transfer Type (S=Single, M=Multiple, X=Many) 
• Primary Transfer date (Sales Date) 
• Stated Consideration (Sales Price) 

 
View Transfer History: 
 Same screens as above, except you can only view them. 
 
 
Update Screening Codes: 
 Same screens as above but you are only allowed to change the 
screening codes. 
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 The following is a
updating a parcel withi
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ProVal Parcel Entry 
ProValPlus 

Basic Documentation 

 

 basic documentation of entering & 
n ProVal.   

here is some basic terminology that might be of some 

 collection of parcels, usually but not always contiguous, 
eristics and economic factors, and viewed as 
ysis and valuation”. All parcels require a neighborhood 

ype – All land is assigned the same property record 
ents have their own property record types. If the 
, the type code starts with an “R”. If commercial, the 
 
ing (or mobile home) can be on one property record 

ultiple outbuildings assigned to the same property 
 dwelling. 
s many property record types on one parcel, as you 
ple, if you have a parcel that has one dwelling, one 

ne commercial building & three outbuildings 
h the dwelling), then you would have the following 
d types on this parcel: 
welling & three outbuildings 
obile Home 
ommercial Building 
g automatic about the code being “R01”.  It could just 
R05”.  In the great scheme of things, it does not matter 
identifier is. 

ard -  (PRC) – The PRC is a printout of the 
ations of a parcel.  This is the “hard copy” for your 
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Existing Parcel: 
 

 

From the File tab, select 
‘Open Parcel’ 

 
 
 
 

 
 

 

By clicking on this option, only the 
active parcels will be listed. 

You can open up a single parcel, or you 
can open up a range of parcels based 
on any of the radio buttons listed to the 
left of either of these screens. 
By using the wild card (%), you can 
open up all parcels starting with 
whatever characters you have keyed in. 
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BASE PARCEL SCREEN F 
E 

A 

B 

C 

D 

 
 
This is the base Parcel screen. This screen will pop up once you decide the parcel 
selection you desire. 

A. These are the different tabs of information.  Depending on what you are 
entering depends on which tab you click. If you click on a different parcel (B) 
the system will change to that parcel for this same tab. 

B. Depending on the range of parcels you open (select neighborhood, etc), the 
list of parcels shows up here. It will assume parcel (PIN) sequence, but you 
can sequence it by Owner, AltPIN, or Address also. To move from the listed 
parcel to another parcel, just click on the parcel entry you need & the screen 
that you are on will change to that parcel. 

C. This is the Applications section. You would go here to edit/enter master 
tables such as land, neighborhoods, costing tables, deprecation, as well as 
report maintenance & other areas. 

D. This is the Memo’s section. Any & all memo’s for the selected parcel will 
show up here. 

E. This toolbar contains selections for items such as pricing parcels, editing 
allocations, printing property record cards, preferences, & other selections. 

F. This is the main toolbar. Most all options dealing with ProVal are in one of 
these master sections. 
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Understanding the Parcel Tree: 
 

 

PIN Tab: 
• If a plus is beside the parcel, this 

means that the parcel has property 
records associated with it. 

• No plus means that there have not 
been any property records assigned 
to this parcel. 

• By clicking on the plus, the 
property records associated with 
this parcel will be detailed out. 

 

 

Owner Tab: 
• By switching to the Owner tab, the 

same parcels in the tree will be listed 
alphabetically by Owner. 

• The same principle applies to the plus 
sign as under the Parcel tab. 

 
Alt-PIN & Address Tabs: 

• Same principles apply here 
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Maintaining the Neighborhood Number: 
 
If the neighborhood number needs to be changed, do the following: 
 

 

From Administration on 
the main toolbar, select 
“Key Info”. 
 
NOTE: Any item on this 
toolbar can be accessed 
from any tab.  

 
 
 

 

This is where the 
neighborhood can be 
changed, if needed. 

 
 
 
NOTE:   During conversion from the UAD data, neighborhoods were not 
necessarily assigned the neighborhood that you are going to use. 
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MAINTAINING THE LAND: 
 
 

 
 
Click on the “Land” tab.  Then, double click the land detail you would like to work 
on.  If the land detail is not in the above screen, see below. 
 

 
 
To add a new land detail record, from the main toolbar, select “Land Detail” then 
select “Add a land detail record”.  
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Click 
when 
finished 

 
Whether adding a new land detail record, or editing an existing land detail record, 
the above screen will be displayed. Of course, if it is a new record, it will not contain 
any information. The Land Type & Method are drop down list.  They will contain 
all entries setup for the neighborhood this parcel is in, or for zero neighborhood. 
Concerning Influence factors, you can up to three different factors with either a 
default percentage or a percentage you keyin. 
 

  
Click the “Price Land” button to price the land.  Now the new entry shows up in 
your master land screen. 
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Improvement Property Records: (Existing) 
 
 

 

Click on the “Improv” tab 
to work on existing 
improvements. 
Select the improvement to 
work on & double click it. 

 
 
 
 
 
 

On this screen, if there is a Value Adjustment or a Value Ad entry, the first 
thing to be done is to delete it, if your purpose is to re-value this parcel for 
certification purposes. If not, DO NOT delete it. 

 
 
 
 
 
 

 

To remove a Value Adjustment, or any other improvement that 
needs to be removed, highlight the entry, then from the 
Improvements option on the main toolbar, select 
“Improvements”, then select “Remove”. 

Say Yes to delete the entry. 
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Special Note about Value Adjustment:  Value adjustments are created during 
the conversion from the AS/400 UAD system.  Since ProVal values it’s parcels based 
on Marshall & Swift & the UAD system values according to the Oregon manual, 
there is always a difference.  Until a parcel is worked on in ProVal & is finalized for 
certification, we need the value of this parcel to remain the same as it was in the 
UAD system.  This value adjustment makes sure that the improvement value that is 
currently in the AS400 is the same in ProVal. 
 
 Improvement Property Records:  (New Improvement) 
 
If a New property Record: 
 

 
 

 

Keyin a description 
(optional), make sure the 
pricing type is correct & 
make sure the property 
class is correct. Select OK 
when done. 

From any tab within the 
parcel, click the 
“Property Records” tab, 
then click “Add a 
Property Record” and 
you will get the 
following screen. 
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Depending on what you are trying to 
define depends on which option to take. 
Generally, if it is a house or a mobile 
home, you will select “Define Segment”. 
If it is anything else, you will select “Add 
Outbuilding”. 

If you selected “Define Segment”, this 
screen will appear. Leave the selection 
as is & click OK. 

At this point, a blank screen 
will appear under the “Sketch” 
tab. To define the 
improvement, RIGHT CLICK 
the mouse (see below). 

 

 

Select “Below Grade”, and then click on “Select” 
(unless not appropriate). 
 Note:  If mobile home, you probably would not 
go into ‘Below Grade’. 
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Click on the options that 
apply, and then click OK. 

 
 

 

When this screen pops up, it will be 
positioned ‘At Grade’.  Click ‘Define’ 

 
 

 11



 

It will assume what’s turned on.  If different, select the appropriate 
selections.  If it is a mobile home, click the ‘Mobile Home’ entry. 
NOTE: Notice that the label in the bottom left is building as we go 
along. 
In our example, we will assume what’s turned on above. 
Once finished, click ‘OK’. 

 
 
 
 
 
 
 
 
 

This screen comes back 
positioned at ‘Upper 
Level’.  If you have upper 
levels, click ‘Define’.  If 
not, click ‘Done’. 
For our example, we are 
clicking done. 
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At this point, 
do the sketch 
for the 
dwelling. 

 
 
 
If any other items need to be defined &/or sketched for this property record, such as 
porches, detached garages, etc., do them at this time.  For this example, we are going 
to add an attached garage. 
 
 

 

From the sketch, right click the mouse, 
then select “Define Segment”. 
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Leave this screen “as is” & 
select “OK”. 

 

 

With this screen setting at ‘Below 
Grade’, click ‘Define’. 
 
Remember … only do this if applicable 

 
 

 

For this example, we are 
selecting “Slab”. 
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Setting at ‘At Grade’, 
click ‘Define’.

 

Click the correct options (in 
this case it is a garage), and 
then click ‘OK’. 
Note:  Take special 
attention to modifier as to 
finished or not.  

 
 
 

 

If there is an upper level, 
define it.  If not, click ‘Done’. 
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Completed Sketch including 
the Garage. 

 

 

If you added any kind of 
outbuilding to the sketch, 
then this screen 
automatically pops up & you 
should fill in the 
characteristics accordingly. 
 
But Remember:  You have 
not done the characteristics 
for the house yet. 
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To enter the 
characteristics into the 
dwelling entry, you can 
select either of these 

(1) From the sketch 
screen, select the 
entry & double 
click, or 

(2)  From the 
“Improv” tab, 
select the entry & 
double click 
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Fill in &/or select entries on this screen, then select the ‘Exterior’ button. 

 

NOTE 1:  During conversion, a sound value is placed on this 
improvement. Once you are re-assessing this parcel for 
assessment drive purposes, change the sound value to “None”.

NOTE 1  



 

If more 
than one 
floor, 
change 
each 
floor. 

Fill in this screen, and then click  ‘Interior’. 

 

 

If more than one floor, 
change each floor 

Fill in this screen, and then select ‘Rooms’ 
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Change the room 
count to what it 
should be.  If 
multiple floors, be 
sure to change each 
floor. 

 
 
 

 

When back to this screen, double check data, then click OK 
when ready. 
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To Value what you have done, click the ‘Value’ tab then click the 
‘PriceCost’ button. 

 

 

From this screen, 
determine what you 
want to price or select 
all, then say OK. 
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At this point, the Value | Buildup screen appears.  This will show you the valuation 
summary values used in determining the Appraised value. 
 

 

If the value is what you feel is 
justified, click the “Save” 
option. 
If not, go back & make the 
changes you feel are necessary. 

Note of Interest:  Since we added a new property 
record type, the parcel tree is now showing it. 
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The Value | Summary screen will show you the %Change from the previous 
Certified Value (if one). 
 

 
 
The Value | History screen will show you the Certification history for the parcel.  
The top pane shows the history summarized by land, improvements & total. The 
bottom pane shows the history by group code (category). 
NOTE: The current appraised worksheet value is not displayed on either of these 
screens until the parcel is certified during the appraisal drive. 
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At this point, the message listed here 
should say, “Parcel has unposted value 
conclusion”, because a change in value 
has been made to this parcel. Do not 
mistake this for being certified. 

Also, when a value change has been 
made to this parcel, the “Need to 
Post” item is checked on. 
If, for whatever reason, you do not 
want this parcel to reflect a value 
change, un-check this item. 

 
Special Note 1:  If the value did not change, then the “Need to Post” flag will not 
come on. 
Special Note 2:  If you have made changes to a property record that has a zero 
value, then the “Need to Post” flag may not come on. 
Special Note 3:  Anytime the “Need to Post” flag does not come on & this parcel 
should be considered in the next re-assessment drive, click it on by clicking the box 
next to “Need to Post” under Value. 
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The following steps should be done if the parcel is to be 
certified for the next assessment drive: 
 
STEP 1: Update the Review Year Memo 
 
 NOTE: You would update the review year memo ONLY if this 
parcel is part of the re-appraisal for the current assessment year (20%). 
If re-valuing a parcel for a previous assessment year, DO NOT change 
the review year. 
 

 
 

 

You can access Memos by 
either selecting the icon 
above, or by selecting the 
option called “Memos” 
from Administration. 
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When this screen comes 
up, select “New memo”. 

 

 

Select the review year memo 
entry from the drop down list 
that reflects the current year 
assessment memo. 

 
STEP 2:  Delete Conversion Memo’s 
 

 

Once you are satisfied with the 
new value of the parcel, the 
memos dealing with the 
conversion, such as ‘DINF’, 
‘DW90’, LADJ  & ‘MADJ’, & 
others, can be deleted.  They are 
not needed any longer.   
To delete a memo, double click the 
main memo line,  then see the next 
screen. 
 
NOTE:  This step is optional 
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Click ‘Delete’ to 
eliminate the 
memo. 

 
 
NOTE:  If you added a current year memo & there is previous review year memos 
from the last time that it was reviewed, this memo(s) will need to be deleted also.  
For example, if you added an ‘RY04’ memo this time & the parcel had a ‘BY99’ & a 
‘LY00’ memo’s on it, delete the old review year memo’s. This step is also optional. 
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STEP 3:   ALLOCATIONS:  At this point, you need to make sure the category 
distribution (group codes) are properly taken care of. 
 
NOTE:  This is where you assign values per category.  In ProVal, group code equals 
category. 
 

 

IMPORTANT: Click the 
“Save” icon BEFORE going into 
Allocations. 

 
 
 
 

 
 
 
 
 

 

To access allocations, you can 
select the option above, OR you 
can select the item “Allocations” 
from the Value Menu as shown to 
the left. 
OR, the fastest way, is to use the 
F9 function key. 
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Check each allocation to 
make sure it is assigned 
correctly. 
To change an allocation, 
click “Edit”. 
To add an allocation, click 
“Add”. 
Special Note:  When a 
new improvement or land 
detail is added to a parcel, 
the entry in allocations is 
assigned either a group 
code of 98 or 99, & it is up 
to you to re-assign it to it’s 
correct allocation. 
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STEP 4:  Inspection Records: 
 

 

 

To edit the Inspection Records 
for this parcel, click the item 
called “Inspection Records” 
from the Property Records 
menu. 
Highlight the entries that are 
to be changed (or Select All), 
fill in the appropriate fields, 
then click “Apply”. 
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ProValPlus Data Entry 
Summary Sheet 
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Fields Within ProVal Data Entry 
Optional or Not ? 

 
 
 

 
 

 1



 

 

 2



 
 
 

 3



 
 

 4



 
 
 

 5



 
 

 6
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NOTE:  Your directory tree on your
you are attaching should already be
 

 

 

 

Image Attachment 
 server should have already been established & the photo’s that 
 residing in the directory they belong to.  

 

Go to Utilities|Imaging 

 

Select Interactive 

 

Enter the parcel the Image will 
be attached to. 



 

Step 1 

Step 2 

 
Step 1:  Browse your directory tree 
to find where the image is stored.  
Starting path for this should be on 
your server under Cama\Images… 
Step 2:  Once you find the image, 
click ‘Add Image’. 
Step 3:  Highlight the property record 
that it belongs to, then click ‘OK’. 
Step 4:  This is the result.  

Step 3 

 

 

Step 4 

Select Exit to 
finish. 

 
 
 
 
 
 
 
 



To Remove an Image: 

 

 

Open a parcel, then select
imaging. 

 

         

Select 
Interactive. 

The parcel that is 
open should be filled 
in this box.  Select O

 



   

Select View 

 

 
Verify the image you want to
remove then select delete. 

 

 

Select OK  

 



Select NO at this prompt.  
 
If you select YES you will actually 
DELETE the image from your file 
server. 

 
 

 

Select Exit. 

 



 

Select EXIT. 
 
(The image will 
continue to 
show until you 
leave the parcel 
then open it 
again.) 

 
 

END 
 
 



ProVal has a fairly effectiv
 

 

ProValPlus Help 

 

e Help system.  

 

Select the Help menu 
item. 

 

For example, I have selected 
to search by the keyword 
Sketch.  Notice the results list 
several returns that would 
involve sketching.   You can 
use any word as a keyword to 
search by, but it is important 
to be as specific as possible 
to get the best results. 




